ADVANCED COMPOSITING FEATURES

Making Footage Work for You

How often have you seen a commercial where the graphics appear glued to a
specific moving visual feature or watched a movie where a floating translucent
high-tech screen has amazing footage playing on what you know can't really
exist. Perhaps you've seen really old footage that’s been restored and is now
steady. Effects such as these are achieved through the application of After
Effects’ Motion Tracking.

Motion Tracking and Stabilization

Of all the technologies programmed into After Effects, | find Motion Tracking
and Stabilization one of the most remarkable. The idea that the computer can
identify a visual feature and follow that feature as it progresses from one frame
to the next is pretty blasé these days, but only a few years ago the technology
was the sole domain of the rarified ultra-high-end visual effects compositing
supercomputer. Then again, today’s ordinary desktop computer clearly lays
waste to yesterday’s supercomputer — and the high-end motion tracking
software has become an everyday feature of many graphics and editing

programs.
Motion Tracking and Stabilization for After Effects operates in four modes:

A Single-Point Tracking

B  Multi-Point Tracking
C  Parallel Corner Pin |'“*E°J*'
D Perspective Corner Pin. Single-Point Tracking
Position Only
H,,iEJ
Torck Point 1 ,__-'r"‘”'

@ = '6; Multi-Point Tracking

Position, Rotate & Scale

Track Puset 2 Track Pont 2
Teack Peiot 1 =

& 5N
’ “" g Parallel Corner Pin /0 Perspective Corner Pin \

(Orthographic) jepomt

N Track Pent 3
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Single-Point Tracking

This is the most basic form of Motion Tracking where the system follows a
single feature — a closely focused area of the image that changes location from
frame to frame. The easiest features to track are highly contrasting clusters of
pixels, where they maintain their contrast throughout their motion track path
(i.e. eyes, corners of windows, computer screen edges, light bulbs).

The image below shows two examples of tracking features, both good and
bad. The concrete has very low contrast and little for the tracking target to lock
on to, whereas the cute little girl has many great features to track.

Single-Point Tracking will often be used for applying visual effects (lens flares,
glows, and character thought bubbles).

Open Motion Tracking.aep and select Pulp Mill — Stabilization. We'll be using
this shot for two purposes: Single-Point Tracking exercise and Multi-Point
Tracking for Stabilization.

Good Tracking Features Poor Tracking Features
High Contrast Low Contrast

176



ADVANCED COMPOSITING FEATURES

For the first exercise we'll be adding a
brilliant flare to one of the lights in the

scene.

1 Select the Pulp Mill - Stabilization
Comp.

2 Right-click layer 1 to track the clip.

3 The menu at right opens — select
Track Motion.

Track Point 1 The Composition Window changes into the Layer

Open Fookage

Reveal Layver Source in Project

Reveal Layver in Project Flowchart View
Reveal Expression Errors

Create Outlines

Track botion I

Stabilize Mation

Inwert Selection
Select Children

Window, where you can apply trackers, adjust Masks

and the clip’s Anchor Point (it's similar to the Footage

Window, but without any clip editing capabilities).

Immediately a Track Point is added to the window.

h The Track Point consists of three elements utilized for
calculating tracker data: the outermost box

(highlighted in magenta) designates the Search

Region. This is the furthest area the tracker will consider for the tracked

feature’s motion changes. The inside box (highlighted here in green) specifies

the Feature Identifier Boundary: the shape, color, and/or luminosity to track.

The cross-hairs identify the Attach Point that will define the tracking data’s

position to be applied to the object (Motion Target) you want to track in the

scene.

Each box is adjustable - the larger the box,
the greater amount of time it takes to track
because it has so much more image to
examine. This can make for a more precise
track (unless there's too much clutter inside
the search area), but usually it's a waste of
time forming the Tracker too large. Also, a
Track Point’s inside box is limited to
searching within the boundaries of the
screen area. It cannot travel outside the
Footage Window's image — the smaller

the Feature Identifier Boundary, the closer

' Track Point 1
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the Tracker approaches the
screen’s edges.

As you move Track Point 1 (drag
inside the boxes, but don’t grab
the cross-hairs), the Track Point
boxes change into a

magnification box of the area

designated by the smaller Track
Point box. This assists with the
precise placement of the
cross-hairs on the feature you're
trying to track. You can also zoom into the image for better placement precision

either by changing the Magnification

Pop Up selector or by rolling the center [Tracker Controls™_

mouse wheel. [ Track Motion | [ Stabiize Motion_|
X . Maotion Source:

When you first opened the Footage Window |

and the Track Point appeared, another

Position I:‘ Rotation I:‘ Scale

Motion Target:

floating window menu opened as well: the
Tracker Controls window. This menu contains

the tools and controls used to adjust then [ Edit Target. | [ options..

S

run your track. Click on the Options button T I S

to access the Motion Tracker Options

window, with its tools used to provide more

accurate tracking and scene pre-processing.

The Tracker Controls window has several functions you can modify: the Motion
Source defines from which clip it will calculate its track, Current Track identifies
which Track Point is currently active for modification, Track Type designates the
operational mode (as described earlier) and, below that, the property (Position,

Rotation, and Scale) to be calculated.

By default, the Single-Point Tracking mode is first selected. Its Track Type,

"Transform’, pre-selects the ‘Position’ property.

4 Ensure that the Layer Window's CTl is at its first frame.

5 Drag the Track Point and place it over any one of the lights in the room.
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Motion Tracker Options

Track Name: |Tracker 1

Tracker Plug-in: | Built-in _:__! Optians
—Channal 1 Process Before Match
" RGE £

| pixels

* Luminance £
" Saturation

2 Track Fields:
v EubpixelPositioning

[™ Adapt Feature On Every Frame
| Extrapolate Mation _=| If confidence Is Below [0

Ok I Cancel

6  Adjust the Track Point to give it enough space (but not too much) to
detect the consecutive positions the light follows.

7  Click on the ‘Options’ button to open the Motion Tracker Options window.

Before you begin any track, you should check the Motion Tracker Options are
set to the appropriate adjustments for the feature you intend to track. The
window consists of filtering techniques to best isolate the tracked feature. In
the Channel section you can choose one of three methods for isolating your
feature’s details: use RGB where individual colors are tracked (i.e. blue objects
over a red background); Luminance is best for high-contrast tracks where the
feature is considerably darker or brighter than its surroundings (as in our
example here); Saturation is where a color is tracked over a similar color
background but of lesser or greater color intensity (i.e. a vivid green flower is

tracked over a dull green pasture).

Process Before Match applies an adjustment to the image prior to the track’s
calculation. Blur xx pixels should be applied to images where the feature’s
surroundings are too detailed and might interfere with the Tracker accuracy.
Enhance applies a sharpen filter to increase an image’s contrast and exaggerate
detail.
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Track Fields is an easily overlooked option that should be activated for all
field-rendered or recorded footage (including 24 fps footage that has not been
3 : 2 Pulldown reduced). It's overlooked because if your field-rendered footage
has been properly prepared via the Interpret Footage’s Remove Fields dialog,
then you won't see any of the tail-tail scan-lines in the Footage or Comp
Windows. If you don't activate the Track Fields function, the item attached to
the track data might appear stuttery or jagged as it moves, with the tracked
footage ruining the whole tracking effect.

Subpixel Positioning should be left on - it's what makes the Tracker smoothly
flow from frame to frame. If turned off, the Tracker data will round to the

nearest pixel, making the motion rough.

Adapt Feature On Every Frame accounts for when the tracked feature
becomes obscured by another image item (like a pole in the foreground
moving across the scene in front of a person being tracked) or when the
feature's surroundings change texture (i.e. color or brightness changes caused
by shadows or blinking lights cast upon the feature). You can instruct what the
Tracker should do if the Adapt Feature’s Confidence (the accuracy of the

Tracker’s calculations) falls below the set percentage.
8 Set the Motion Tracker Options to the highlighted settings: Luminance
and Track Fields.
9 Click ‘'OK’ and return to the Footage Window to add our effect.

10 Right-click on the Pulp Mill. mov layer and select > Effect > Render >
Lens Flare.

11 In the Effect Controls window, set ‘Flare Brightness’ to 75% and the
‘Lens Type' to 105 Prime.

A Quick Word on the Disrespected Lens Flare: The bad reputation placed upon
them is undeserved. They serve a great purpose — an appropriately designed and
well-placed moving flare can provide a scene the sense of depth and life animation
often lacks. The fact is that animation is often too clean and clear from computer-
derived purity. For the best Lens Flare effects plug-in, consider the Knoll Light
Factory 2 toolset (available from ToolFarm.com). This is a powerful set of pre-
designed and customizable optical effects that will quite simply amaze your friends,
astound your clients, and pay for itself in no time.
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| OnoB0 OO0S0__Onion aoiio ool
Wiew: Lens Flare [ L Render |
o "

Now that you've assigned your Lens
Flare to your clip you need to instruct
the tracker to apply its data to the

flare’s center point. But since you

added the Lens Flare, the Tracker Controls menu has

become inaccessible. To reacquire the Tracker Controls
you need to change the Footage Window's View:
selector (close to the bottom edge of the Footage
Window) from Lens Flare to Motion Tracker Points. This

hides the Lens Flare and returns to the Track Point

Maone

Tokion Tracker&oints

Masks il
Anchor Poink Path
v Lens Flare

screen, while reactivating the Tracker Controls menu.

12 Click on Edit Target in the Tracker Controls menu.

13 The Motion Target window opens and has selected the Lens Flare's

Center as its point control — click ‘OK’".

If your scene had many

effects that can use Tracker

.Molinn"‘uluol
spoly Moton T | or other layers to apply the
e Ly I I | .
Tracker's data, the Motion
* Effect paint control: | Fris Flare Flare Center -
Target menu would offer
=l coxm many more selections in its

drop-down menu.

Now that you've placed the Track Point and set the Motion Target, your motion

track is ready to proceed.

14 Click on the Track Forward
arrow in the Tracker Controls

menu (seen at right).

15 Once it has finished its track,
click ‘Apply’.

Another menu pops up - the Motion
Tracker Apply Options allows you to
select how the data will be applied to

Transfarm

I:' Rotation

Track Type:

Pasition

Maotion Target:

Edit Target. | [ opton. |
7
dnalyze: | ﬂ ﬁ‘; “-

I:l Scale

your target. This is convenient when you want to restrict your target’s motions

to one axis of motion.
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Motion Tracker Apply Options

lXandY vi

16 Click 'OK’ in the Motion Tracker
Apply Options menu.

Apply Dimensions:

=T 17 Click on the Return to Comp
ance
Button at the bottom edge of
the Layer Window to review the
Tracker’s results.
18 Run an RAM Preview. :
070 DOUS0__ 00090 N0100 00110
19 Repeat the procedure to 4 iew:Mation ~cscker Pouts w| W/ Fands:
apply another Lens Flare on - X -

the other light near the first
tracker.

For a challenge, try tracking the light on the left middle screen. It looks easy
enough until the steam obscures the light. This is a great example of where to
use the Adapt Feature On Every Frame in the Motion Tracker Options dialog.

Multi-Point Tracking — Position and Rotate

Imagine you have some footage that was shot by a director of photography
schooled in the MonkeyCam genre, or perhaps you are given a clip shot while
the camera operator stood atop a platform with heavy machinery vibrating the
platform viciously. Maybe you have an object in a scene where you need to
attach a graphic sign but the object that you need to track both rotates and
changes size at the same time.

These are examples where Multi-Point Tracking is appropriate. Both Stabilization
of shaky footage and Motion Tracking of rotating and/or scaling features are
types of Multi-Point Tracking. And fortunately for us, we have excellent case

studies of both to practice upon.

Revert the Motion Track.aep project and again

Open Fookage

Reveal Layver Source in Project

Fewveal Laver in Project Flowchark Yiew
Reveal Expression Errors

select the Pulp Mill - Stabilization Comp. You've
already seen that this footage was difficult to

so let’s fix it using Multi-Point Tracking.

shoot due to the heavy machinery environment, ‘

1  Open the Pulp Mill.mov clip’s Layer
Window by right-clicking on the clip,
but this time select > Stabilize Motion.
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Invvert Selection
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2 Make sure that the Layer Window’s CTl is at first frame.

The Track Type should already be set to Stabilize, but the only property to be

stabilized is the Position. Our footage has serious twists combined with its jitter,
so the Rotation property needs to be selected. When a two-point track is used,
a rubber-band line connects the two Track Points, with the first Tracker pointing
to the second. The change in angle of this line determines the image’s rotation

factor.

3 Click the Rotation check-box to add this property to the track.

4 Drag ‘Track Point 1’, aligning it to the pulp conveyor’s left far back

corner.

5 Drag ‘Track Point 2’ horizontally across the conveyor, aligning it to the

black dot near its right edge (seen below).

6 Open Options . .. in the Tracker Controls menu and activate Fields in

the Motion Stabilizer Options (this is the same dialog as the Motion
Tracker Options dialog), and click ‘OK'.

7  Return to the Tracker Controls and run your track.
8  Click on ‘Apply’, then click on the Return to Comp Button.

9 Run an RAM Preview.

The Motion Target for the track was already pre-selected to the clip itself. So
when you clicked ‘Apply’, the clip inherited the Keyframes generated by the
Tracker for Position and Rotation.
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184

As you run the preview notice
that the image becomes
greatly offset from its initial
position. Also note that the
layer's Anchor Point
(highlighted in magenta at
left) is aligned with where the
Tracker's first Track Point was
set — this is the point where

the image also pivots.

As it stands right now, the
Stabilization is not very
usable: the image is too far
offscreen, with vast areas of
black filling the view. You'll
need to center the clip and
simultaneously expand it to
fill the screen, as much as
possible. The most effective
technique to accomplish this
task is by Parenting the layer
to a Null, then using the Null
to both reposition and scale
the whole clip.

10 Add a Null to the
Timeline (Ctrl + Alt +
Shift +Y).

11 Parent the Pulp
Mill.mov layer to the
Null (Shift + F4 opens

the Parent column).

12 Adjust the Scale of
the Null to
approximately 110%.
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13  Scrub the CTI through the Timeline to find a point where the image no

longer moves abruptly.

14 Drag the Null through the Comp Window until the Parented layer
appears roughly centered — you may have to scrub the CTl a few times
to find a good compromise for the image’s center.

The only remaining issue with the
clip is at its beginning: the camera
move makes a tilt until it steadies
upon the machinery. Again, the
Null offers a solution — you'll add
two Keyframes to account for the
camera’s initial downward angle,

then move the Null to its current
position for the remainder of the
clip's playback.

15 Add a Position Keyframe (Shift + Alt + P) to frame 34, where the clip
has finished its tilt.

16 Return to the first frame (Home) and move the Null upwards to

compensate for the tilt.

17 Add an Easy Ease (Shift + F9) to the second Keyframe to make the tilt

transition smooth.
18 Increment and Save your work, then run another Preview.

The Stabilization is now complete. Even with the image’s slight scale increase,

the overall effect improves greatly upon the original’s wobbly shot.

Multi-Point Tracking — Scale

There's one additional Property that can be calculated by Multi-Point
Tracking — Scale. By adding Scale, an object can be effectively tracked in 3D
space, though it's only acting on 2D data.

Revert the Motion Tracking.aep project, then open the Chuck’s Chips — Tracker

Comp. Our task is to glue a sign to the back of the truck’s rear hatch, covering

the oval logo above the red and white safety stripes. This is a difficult tracking
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problem for several reasons: the
chips dumping out of the truck add
a lot of noise to the shot, the shot
doesn't have any well-defined
features in which to apply Trackers,
and the feature to track moves into

then out of the screen.

For cases where the feature comes

from or moves offscreen, you have

to manually adjust the tracked

overlay to account for the offscreen motion.
But other than these offscreen issues,
preparing for a Scale Track is the same as any
other Multi-Point Tracking:

1 To ease the Tracker’s setup, choose a
frame toward the center of the clip
(frame 40).

2 Right-click on the clip layer and
select > Track Motion.

3 Check 'Rotation’ and ‘Scale’, in
addition to ‘Position’.

Tracker Controls

[ Track Motion | [ Stabilize Motion |

Mation Seurce: | Chuck's Chips.may |v

Fosition Fotation Scale

Motion Target:

=

[ Edit Target.. ] [ Cptions...

| B R |

4 Click on Options.. . ..

Tracker Plug-in: | Built-in

186

5 Select both 'RGB’ and ‘Track Fields’,

then 'OK'.
—Channel
< ReE We're using RGB to track the features
 Lurninance because they have strong color and
" Saturation luminance differences.

The Motion Target is blank because there's

¥ Subpixel Positioning nothing yet in the Comp to apply the
I Adapt Feature On Every Frarm: Tracker's data. A good habit to follow is to
| Adapt Feature use Nulls for applying your data. This allows

you to make further adjustments to your

tracked object after the Track is complete.
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6  Press 'Ctrl + Alt + b
—— Appby MOt Toe -
Shift + Y’ to add a e [ =
Null Object. € Effectploutiol |
7 Click on Edit et e | e |

Target . . ., then
press ‘OK’ — the Null
is the only thing in the scene for the Tracker to use.

8  Align the Track Points to the lower
corners of the door nearest to the
oval logo — place Track Point 1 to
the right and Track Point 2 at left.

Motion Target:

[ Edit Target. | [ optiens. |
The Tracker Controls menu has four ELESE (N I N S
buttons to activate your track: Single Apply
Frame Track Back, Reverse Track, and
Single Frame Track Forward. Previously, ‘ldl Single Frame Track Back
we've been using Track Forward, but "ﬂ Reverse Track

since we set up the Track Points within Track E d
the middle of our clip, this requires h FACK NOPea)
reverse tracking. | Single Frame Track Forward

il Stop Track

9 Click on Reverse Track to run your
Track, but as the Track points
approach the screen’s edge, click on the Stop Track button (the Play
becomes the Stop button).

10 Manually step the Tracker backward with Single Frame Track Back to
bring the Track Points center box as close to the screen edge as

possible.

11 Jump back to frame 40 (Ctrl + G) and resume your Track Forward, but

again stop the Track as it approaches the screen edge.

12 Manually step the Tracker forward with Single Frame Track Forward to
bring the Track Points center box as close to the screen edge as possible.
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13 Click on ‘Apply’, then in the Motion Tracker Apply Options dialog click

14

'OK’ to transfer the data to the Null.

Click on the Return to Comp Button and then scrub the CTI to review

the Tracker's results.

Select the Null 1 layer, then press ‘U’ to examine its Keyframes for all three

properties: Position, Rotate, and Scale. Because the Trackers are limited to

staying inside the image area, you have to manually extrapolate the offscreen

track data.
15 In the Timeline Window return to frame 0.
16 Drag the Null up to align it to the same feature point just inside the
screen.
17 Go to the last frame

A good trick in offscreen

(End); you'll need to
scrub the CTl and
tweak the Null,
guessing where the
feature would be
offscreen.

feature situations such as this is to use the Null’s edges to line up with some

other item in the scene that is common to the offscreen feature — in this case,

we'll use the door’s blue frame.

The only activity left is to add an item to attach to the Null.

188

18 Go to frame 40 to prepare the
new layer for attaching to
the Null.

19 Drag Chuck’s Sign Comp from the
Project Window into the Chuck’s
Chips — Tracker Comp as layer 1.

20 Scale the new layer to 15% then
move it, placing the sign near
the edge of the truck’s door
frame.
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21 Right-click on Chuck’s Sign layer =~ [#chuck’s Siga 15

Chuck's Chips - Tracker ¥ Chuck's Sign |
and add > Effect > Distort > = [f Transform Razet About... »
Animation Presets 4
Transform to the layer. + ] Anchor Paint =
+ ] Position
22 Adjust the Skew (not Skew Axis) e
[ & Seale
to 7.0. b
[ & Skew Fo
23 Parent Chuck’s Sign layer to the 7 Ol slew duci AxA0RT
Null 1 layer. @
= | Rotation O +0.0 ¢
24 Activate the Motion Blur switch @
on Chuck’s Sign layer and the b &) Opacity 1000
. ., . (s} R Use C ition's Shutter...
Timeline’s Enable Motion Blur. b jsmtter o _g___g;_e R -

25 Run a Preview.

The sign is effectively attached to the truck’s doorframe. The Motion Blur adds
even more realism by blending the sign into the frame. To really make the
effect even more convincing, you could add some noise and color correction to

match the image’s texture.

Corner Pin Tracking — Parallel and Perspective

We've all seen them — the replacement image tracked inside a TV monitor, the
moving-footage photo album, or the animated sign high on a billboard. These
are examples of Corner Pin Tracking: the application of a rectangular image
distorted to fit within another rectangular moving space. Corner Pin Tracking

works in conjunction with the > Effect > Distort > Corner Pin.
There are two modes of Corner Pinning:

e Parallel - this mode (top example, next page) is best described as
skewing an image where each opposing side remains parallel to each
other. Architects would call this orthographic projection. With this mode
you only assign three of your four Tracker Points — the fourth is a
‘virtual’ point that is extrapolated to ensure the shape remains a
parallelogram.

e Perspective — this mode (bottom example, next page) allows for complete
freedom of all four Tracker Points, resulting in an image that matches real-
world camera angles more accurately.
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Track Point 2

Track Point 1

”'”""'----.._______Track Point 4

Parallel Corner Pin Yirtual

(Orthographic)

Track Point

— Opposite Lines
are Parallel

All Lines Independent

Track Point 1 / \

Track Point 2

12

PerspectivelCorner Pin

Trac PDT_I___J__—J—__J E

Returning to the Motion Tracking.aep project, select the Palm — CornerPin
Comp. This project offers a common application of Perspective Corner Pinning

(but you can try Parallel as well).

Double-click to open the shot in the Layer
Window. Scrub the CTI to review the footage
and how it moves. Notice that the track
points adhered to the PDA's screen have
great contrast, but as they move away they
change size so severely that the Trackers
might become confused to their original
placement. This example will work best as a

Reverse Track.

For our inserted image Motion Target, we'll
be using the previously stabilized Pulp

Mill - Stabilization footage Comp.
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1  From the Project Window, drag your Stabilization test Comp (or dig into
the Solutions folder and grab the Pulp Mill — Stabilize Solution) into the
Palm — CornerPin Comp's Timeline.

2  Snap the Pulp Mill's end frame to the last frame of the Palm Comp.

-
nerPin J\I\Chuck 's Chipz - Tracker "\F'alm CornerFinmoy I \I{__
7

3  Return to the Palm CornerPin.mov Layer Window by clicking on the Tab
at the top of the Comp Window (or double-click the layer again).

4  Activate the Tracker by clicking on the Stabilize
‘Track Motion’ button in the Tracker Tranzform
Controls floater window. Farallel corner pin

Ferspective corner pin

5  Click the Track Type drop-down and select Faw
‘Perspective corner pin’.

[Tracker Controls™,__
The three Properties have all been subdued
[ Trackmotion | [ Stabilize Mation |

because this special instance of tracking only

works with the Corner Pin distortion effect.

6

Motion Source: m@
Current Track: IWE
Open the Options e and set the Track Type: PFerspective corner.
Channel to Luminance, Track Fields, e I o M
and activate the Process Before Motion Target: Fulp Mill - 5..Jize Salution
Match - Enhance, then click ‘OK’.

[ Edit Target. | [ options.. |

Analyze: | - |
Jump to the last frame (End) to set

[ Rezet ] [ Apply ]

your Tracker Points, placing each

Track Point’s center upon the outermost

corner of the tracker marks.

Drag the cross-hair Attach Point from
each Tracker Point’s center to expand
the Corner Pin frame coverage, fully
obscuring the PDAS'’s tracker marks.

Reduce the size of each Track Point to

restrict the search areas - this will help
when the track markers become so small.
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The advantage of repositioning Tracker Attach points is most clear when you
have an object with features that must be covered by the tracked overlay.
Sometimes the best Track Point will be different from where you need the

tracked image to align.

Compare the two images above and you can see how the expanded Attach Points

form a more encompassing image area that obstructs the adhered track marks.

10  Run the Track in reverse, then stop it prior to where the Tracker Points
run into the screen’s edge.
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11 Apply the Tracking Data to the Pulp Mill layer.

12 Return to the Composition Window and run a Preview.
The Perspective Corner Pin should have worked well enough for this
exercise, but if this were a client’s project you might have to extend fully

the overlay’s track, forcing you to manually extend the Track Points
offscreen.

This brings up one last important issue with Motion Tracking - fixing aberrant

‘
B

Tracker errors.

When Tracking Goes Awry

The Palm - CornerPin footage is a good
example of a difficult track due to the
PDA track marker’s size change. But
there are many other far worse problems
you can encounter: obscuration by
foreground interference, excessive
motion blur, extraneous intermittent
environmental artifacts (flashing lights),
to name just a few.

Revert to the Motion Tracking.aep
project one more time, then return to
the Pulp Mill - Stabilization Comp. As

we've previously seen, there are many

excellent features to track in this
shot — and one troublemaker that's hard

1]
‘
0

193

In the Pulp footage there’s a light to the
left of the conveyor that becomes
obscured by steam billowing out from
the machinery. Try to perform a Track
Motion on this feature and you'll quickly

h
b
Fi
i
9

discover that it's not so simple a task.
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6

Channel | Process Before Match
" REB e [ pels
% Lurninance € Enhance
" Saturation

v Track Fields
v Subpixel Positioning
v Adapt Feature On Every Frame

Continue Tracking _v_| If Confidence Is Below |EBD %

Continue Tracking

Stop Tracking (04 I Cancel
I A = L\\f

Add a Null to the Comp.

Open Pulp Mill.mov in the Layer Window and set up a Track
Motion > Transform > Position.

Set the Edit Target . . . to the Null.

Place the Track Point over the steam-blocked light and make the
Feature and Search boxes relatively small to limit interference as you
run the track.

In the Options . . . dialog, activate Luminance, Track Fields, and set
Adapt Feature On Every Frame to Extrapolate Motion, then ‘OK".

Run the ‘Track Forward’ and watch the disorder ensue.

The Track holds for about 40 frames then loses lock, even with the Adapt

Feature option on. Times like this call for manual adjustment and Single-Frame
Tracking.

7
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Reset the Track Controls, jump to frame 25, and again place the Track
Point over the light.

Zoom into the image 400% (press the Period key twice) and adjust the
Track Point’s boxes tightly around the feature.

At frame 25, click on the Single Frame Forward to set your first Tracker
Keyframe.
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10 Use the keyboard's Page Up and Down (PgUp, PgDn) buttons to

advance the Layer Window's CTI three to five frames.

11 Reposition the Tracker Point manually using the mouse to re-center over
the feature; be ready to use ‘Ctrl + Z' to Undo any errors you make
when moving the Track Point.

12 Repeat steps 8 and 9 using your good judgement to what constitutes
an acceptable loss of lock — try using the Single Frame Forward button
now and then to see if the feature is clear enough for an automatic
track.

13 At approximately frame 85, deactivate the Option > Adapt
Feature . . ., then resume the continuous Track Forward until it loses
lock again.

After a while the Tracker is all in turmoil — to resume manual Tracking you'll
need to remove some of the previously gathered data. The Tracker stores its
track info in the Pulp Mill.mov layer's Timeline. Open the layer (press ‘U’ to
reveal all Keyframes) to examine all the Tracker data Keyframes created so far
(seen below). The first half shows the intermittent manual tracks, while from 85
onward are the sequential automatic tracks. To correct the bad data, delete the
offending Keyframes, then repeat your track beginning from the point of the

first deleted frame.

Occasionally the Track might throw a sporadic wig-out and then return to
normal. For those spikes, manually place the Tracker Point back centered on
the feature. However, keep alert to the Tracker’s Attach Point cross-hairs — this
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THE FOCAL EASY GUIDE TO AFTER EFFECTS

needs to be kept in line with the track path

as a whole. When the Tracker goes off
half-cocked, the Attach Point goes with it.

14

15

16

17

18

Use the cursor to select all the
Keyframes from about 120 onwards,
then press ‘Delete’.

Return to the Layer Window and
resume the track process, using the

Track Forward button this time.

Once complete, scrub the CTI to find
any aberrant Tracker Keyframes, then re-center them atop the
feature - be sure to place the Attach Point back in the center of the

Tracker where needed.

Once all the latter Tracks are complete, jump back to frame 25, then run

a Reverse Track to finish the process.

Apply the Tracker’s data to the Null, then return to the Comp Window
to review the track by scrubbing the CTI - look for any additional bad
tracks that need to be manually adjusted.

From now on, you can simply adjust the Null’s position to correct for any

Tracking errors. But once you select the Null layer, the footage becomes

obliterated by countless Tracker Keyframes and its path. Open the
> Edit > Preferences > Display dialog to disable the ‘Motion Path’. You can

then resume your manual repair of the bad track and use the Null as a Parent

for whatever element you need to add to the scene.
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